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1 PEICOMP - GENERAL:  
This program was designed to calculate set of coefficients that is used for magnetic 

compensation. Magnetic compensation is performed by PEIView program using 
calculated coefficients.

1.1 REQUIREMENT FOR MAGNETIC COMPENSATION

Modern magnetometers and signal processing boards for magnetic measurements 
now enable  both high sensitivity  and high sampling  rates  to  be coupled with a  broad 
bandwidth.  The magnetic interference from the airframe or even the sensor itself due to 
attitude changes are far greater than the inherent resolution of the system.  Changing of 
magnetic parts and the use of coils and permalloy strips can only partially remove the 
interference effects.  Proper magnetic compensation, either in real time or post processing 
is necessary to remove the aircraft’s interference.  The compensation must address all of 
the interference sources.  Magnetic compensation is now the limiting factor in the overall 
useful sensitivity of airborne magnetic surveys.

It  has been our philosophy to use very much a graphical approach to magnetic 
compensation so that the operators can always see down to the noise levels of the system. 
By this  technique interference effects  can often be seen immediately and cured before 
expensive airtime is wasted.

Additionally we recommend the use of wide bandwidth, which must be matched for 
the  magnetometer  and  the  compensating  fluxgate.   We recommend  the  use  of  10  Hz 
sampling with a 2 Hz bandwidth to reduce the effects of aliasing.  

The  Pico Envirotec method uses purely software techniques, without the use of 
varying  currents  and  coils  which  can  distort  the  field  around  the  sensor.   The  Pico 
Envirotec method records the compensated data and all of the required raw data necessary 
to re-compensate the magnetometer data in post processing.

1.2 SOURCES OF MAGNETIC INTERFERENCE

Magnetic interference in a geophysical  aircraft  environment comes from several 
sources.  These include:

A) Permanent magnetism, mainly from engines and other 'hard iron' magnetic 
components close to the sensor.  This interference is proportional to the coupling with the 
magnetic field.
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B) Induced magnetism, from 'soft iron' components close to the sensor.  This 
interference is proportional to the coupling with the magnetic field and the magnitude of 
the magnetic field and is a function of the susceptibility of these components.

C) Eddy current  terms,  from rate  of  change  of  movement  of  conductive 
surfaces in a magnetic field.  This interference is proportional to the coupling with the 
magnetic field; its magnitude and the rate of change of altitude. 

D) Heading effects of the magnetometer sensor itself.

E) Altitude changes in a vertical magnetic gradient.

F) Additional effects come from moving surfaces and materials, such as trim 
surfaces and push rods, and distortions of the airframe through flexing. 

G) Electrical and mechanical interference in the pass band of the system.

The order of magnitude of these interference effects varies greatly from installation 
to installation.  Typically permanent terms could bring 10 nT of magnetic interference, the 
induced  terms  5  nT  and  eddy  current  terms  2  nT.   The  heading  effects  of  modern 
magnetometers can be as much as 0.5 nT while the vertical magnetic gradient at 3000 m. 
above ground is of the order or 30 pT/m or 10 pT/ft.  

On  a  fairly  clean  magnetic  installation  moving  surface  and  electrical  and 
mechanical interference should be better than 1 nT.  These can be tested on the ground in a 
quiet location with the sensor held in a rigid position.  As these interference sources are not 
measured they will affect the residual compensation and should be minimised.  In fact the 
cleaner the installation, with respect to these unmeasured interference effects, the poorer is 
the overall improvement by this compensation.

The main differences  in  these terms can be seen in their  magnitude and phase 
relative to a sinusoidal motion.

The permanent interference effect would be in phase with this motion.

The  induced  component  is  again  in  phase  with  the  coupling  but  with  only  an 
increasing effect of the measured field,  maximum along the north and south directions 
where coupling with the magnetic field is greatest.

The eddy current term has a magnitude proportional to the absolute value of the 
magnetic field coupling and to the rate of change of coupling.
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Above we show individual interference effects for a sinusoidal motion.  They can 
be at the frequency of the motion, both in phase and 90 degree phase shifted.  They can 
also have a frequency twice that of the motion, again in or 90 degree phase shifted.  The 
resulting  magnetic  interference  is  the  vector  sum.   This  can  have  a  complex  shape, 
depending on the magnitudes of the interference.

1.3 REALITY IN COMPENSATING A REAL AIRCRAFT
The residual magnetic interference is somewhat more complex that a simple sine 

wave manoeuvre.  In reality the magnetic interference is in three dimensions, longitudinal, 
transverse and vertical.   Additionally the components in each dimension have different 
interference effects from pitch, roll and yaw motions.  Similar phase shifted responses exist 
for the for rolls and pitches.  The summed interference is much more complex as the three 
dimensional attitude and rate of change of attitude of a real aircraft is inter-related.

In a real environment the aircraft is also moving through a changing magnetic field. 
Even high above ground level there still exists long wavelength gradients and curvature in 
the magnetic field.  By carrying out a box manoeuvre the background magnetic gradient 
changes at the same time as the heading effect of the aircraft.  This makes it extremely 
difficult to separate the two effects.

1.4 BASES OF COMPENSATION

The basis of our compensation is the reduction of motion induced noise on the 
selected  magnetic  elements.   These  can  be  individual  sensor  or  various  gradient 
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configurations.  This motion noise comes from the complex three-dimensional magnetic 
signature of the airframe as it changes attitude with respect to the magnetic field vector. 
The noise comes from permanent, induced and eddy effects of the airframe plus additional 
heading effects of the individual Cs sensors.

Due to the background magnetic  changes experienced in real  flying conditions, 
long wavelength geological interference,  it  is felt that  it  is not easy to obtain adequate 
compensation coefficients, which can be used on all survey headings.  Only in extremely 
low gradient areas would this technique give reasonable results.  This is due to the fact that 
these  background  changes  alter  with  the  heading  and  have  the  same  high  frequency 
components.   They  are,  therefore,  indistinguishable  from  heading  effects  due  to  the 
airframe  alone.   Attempts  to  use  1  set  of  coefficients  for  all  headings  average  these 
background errors into the compensation coefficients and produce inferior results during 
compensation.

Our approach has been to use four individual sets of coefficients, one each for the 
four cardinal headings.  These are assigned to be nominally  'N', 'S', 'E' and 'W'.  On survey 
the changes from the nominal line are small, typically within +-20 degrees for pitch, roll 
and yaw.

We define 4 cardinal headings for each survey,  even if only 2 are used.  These 
cardinal  headings  are  normally,  but  not  necessarily,  orthogonal.   The  Main  Cardinal 
Heading is defined as the grid value of the cardinal heading closest to grid north.  For 
example, the main survey direction is on a heading of 100 degrees east of grid north then 
the cardinal headings are 10, 100, 190 and 280 degrees with the Main Cardinal Heading 10. 
We then define our 10-degree east heading as 'NORTH'.  Similarly the 100-degree heading 
is defined 'EAST', the 190 deg heading as 'SOUTH' and the 280 degree heading as 'WEST'. 
This convention will be carried through from the SURVEY program to post-processing.

The magnetic compensation is carried out in software without the use of active 
distorting magnetic fields.  A magnetic interference model has been constructed with three 
orthogonal sets of components.  This assumes a magnetically rigid magnetic interference 
model.  

A three-axis fluxgate is used to measure the coupling of the three axes with the 
background magnetic field.  This sensor is very sensitive to attitude changes and is used to 
accurately monitor the aircraft reference frame.  The frequency response and sample rate of 
the PEI Analog Processor card used to measure the fluxgate signals is the same as that of 
the  PEI Magnetometer Processor card.  This means that there is no phase distortion of 
these synchronised measurements.  This leads to improved compensation throughout the 
pass band of the system.  

A series of pitch, roll and yaw motions are carried out on each survey direction to 
vary this coupling and gather fluxgate, barometric and measured magnetic field data.  This 
data is processed using a ridge regression technique to find a stable set of coefficients for 
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the model.   When the compensation algorithm is run using the model and coefficients, 
either in real-time or post-processing, a magnetically compensated data set is generated.

We have tried to make this software as production orientated as possible, to supply 
the operator with real-time compensated data to view, confirming that it meets company 
specifications, and continue flying.

The  programs  supplied  should  enable  the  user  to  achieve  software  magnetic 
compensation for total field data.  This can be carried out in real-time using previously 
calculated  compensation  coefficients  or  in  post-processing  using  a  selection  of 
compensation coefficients.

1.5 STAGES OF COMPENSATION

The compensation takes four stages:

A) Acquisition of motion test data.

B) Reduction of this data to produce compensation coefficients.

C) Production use of these coefficients  in  real  time to  supply compensated 
magnetic elements.

D) Post processing, if desired, of the raw data with other sets of compensation 
coefficients for improved results, if valid.

1.6 ACQUISITION WITH AGIS / IRIS

The acquisition of motion test data should take approximately 20 minutes.  Let us 
consider that we want to fly N-S traverses and E-W tie lines.  The test should consist of the 
following:-

1) Have all equipment in normal operating conditions.  The sample rate should be 
that of the survey.  10 Hz sampling with a 2 Hz bandwidth is recommended for all surveys. 
All the equipment that would normally be “ON” during a survey flight should on. If the 
aircraft  is  equipped  with  an  auto-pilot  it  should  be  turned  off  and  the  aircraft  flown 
manually. Aircraft systems that consume large amounts of power  such as air conditioning 
should be either turned off and left off or placed in a mode where the compressor and fan 
systems are continually on and do not cycle.  It  should be noted that  whatever  aircraft 
systems are on during the compensation test flight must be “ON” for all surveys flights. 
Failure to observe this practice will result in poor compensation results during survey data 
acquisition. 
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2) The pilot(s) should be consulted to ensure they understand the following, often 
somewhat conflicting, ideal requirements.

The compensation test should be carried out in a magnetically quiet area at high 
altitude,  away from ground effect,  at  least  8,000 feet  above ground.  The normal  data 
acquisition program should be run with the sample rate the same as that to be used in the 
survey.    During each of the four lines the aircraft should perform three each complete 
pitch, roll and yaw motions.  These should be smooth and as symmetrical as is possible, of 
typically 5-10 second period.  

The motions should be consistent with normal aircraft motion experienced during 
survey data  acquisition.  Roll  manoeuvres  should be +/-10 degrees  peak to  peak,  pitch 
manoeuvres  should be +/-5 degrees  peak to  peak and altitude  changes  should  also be 
minimised, 50 m. or less if possible, and yaw manoeuvres should be +/- 5 degrees peak to 
peak.  Only the aircraft surfaces that are used on line to alter the aircraft attitude should be 
used, e.g. do not use rudder excessively if this is not normally used as magnetic push rods 
may complicate the compensation.  The order of motions is not critical.  It is, however, 
good procedure and enables us to view the replot in a more meaningful way.  The line 
should be closed, the aircraft set on a new heading, e.g. west, and the same motions carried 
out.   The  motions  should  then  be  carried  out  again  on  the  remaining  south  and  east 
headings. IN order to assist in data analysis the operator should note on the flight log the 
start and end fiducials for each of the 12 manoeuvres.

The operator should then have four separate data files named B???????.P??, if data 
is  collected using an AGIS /  IRIS data  system.  An example  would be B6011909.p00, 
B6011909.p01 for data gathered on January 19, 2006 at 9 o’clock.

The reduction of the data to calculate the coefficients can be carried out on the 
aircraft but is easier to do it on the ground, either on the aircraft system or a similar PC 
computer.  It is recommended that a plot is carried out of the data at the fastest sample rate 
to view the fluxgate and the magnetometer signals to ensure that there are no glitches or 
other problems with the data.  The user should also select the fid (record) ranges to use for 
each heading.  There should be from 800 to 2000 data samples for each line.

It is recommended that this test procedure should be carried out at the beginning of 
each survey and every two weeks or whenever any major magnetic component is changed.
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2 PEICOMPENSATION - USE  
2.1 INSTALL / SETUP THE PROGRAM
PEICompensation  program  is  included  into  PEI  Support  Programs  package  and 

installed together  with other PEI software.  See Program Installation manual  for more 
details.

After installation shortcut to PEICompensation application (PEIComp) is created on 
the computer desktop and in Start / All Programs menu:

2.2 WORKING WITH PEICOMP PROGRAM
2.2.1 Introduction
The compensation box flight data serves as source data for PeiComp program. During 

flight  each  heading  data  can  be  recorded  in  separate  file  or  all  four  headings  data 
recorded into one file. 

If there is no data for all four ortogonal headings, compensation coefficients can be 
calculated for existing headings.

PEIComp program accepts files in PEI binary data format. If the source data saved as 
ASCII format  file,  there is  provision to convert  it  to Pico Envirotec data format  (see 
section 2.2.5).

When the file is loaded in PEIComp program, the user has to specify  magnetic  and 
position data needed for coefficients calculation: fluxgate magnetometer data channels 
(x, y, z), raw magnetometer data channel(s), altitude, X and Y position data. The X and Y 
coordinate are used for heading calculation.

 Then  select the proper data  range of each heading from the source file(s) and 
save it in a separate range file. If four headins data is present, four separate range files 
have to be created.

The next step is to calculate coefficients of each heading using range files as source 
data. The user can correct range file data before calculation. 
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Finally, when all headings are processed,  calculated coefficients are saved into the 
coefficient file.  

2.2.2 Create Range File
Once the program is started and goes through a “splash” screen the operator should 

open a file that contains necessary data channels for coefficients calculation. 

All file channels are listed in Selelect Channel drop down list. Select the data required 
for the coefficients calculation. Start with X-fluxgate channel:

       © Pico Envirotec Inc.                                                                                         10 / 25 



PEICompensation February 2009

Once a  channel  is  selected;  the  Channel  Type 
options window will appear. The user has to indicate 
type of the channel. The selected channel data will 
be displayed on the corresponding chart.  The user 
can adjust the scale.
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Continue with all required channels:
o X-fluxgate
o Y-fluxgate
o Z-fluxgate
o Raw magnetometer data (up to four channels)
o Altitude 
o Record channel (optional)

Note:  After  X-fluxgate  channel  is  selected, 
Y-fluxgate and Z-fluxgate channels are selected 
automatically. Information message will appear:

Heading  channel  might  be  opened for  assistance;  place  it  in  the bottom chart  by 
selecting ‘Other’ radio button in Channel Type dialog box.

After all channels are selected screen will look similar to the following:

If more than one raw magnetometer data channel is present it might be difficult to 
view clearly  all  the graphs.  It  is  possible  to  remove (clear),  hide  and show any raw 
magnetic data graph. Click with right mouse button (right-click) on the channel name 
label, pop up menu appears: 
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After ‘Hide Graph’ item is clicked,  data  channel is  still  selected but graph is not 
visible:

There is an option ‘Show all Samples’ that can be set with a check box located at the 
bottom left corner of the window. If this option is selected additional chart will appear 
when mouse pointer is placed over fluxgate channel or raw magnetometer data channel. 
This chart shows all samples of the current record.
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If all necessary data channels are selected the user can specify the record range that 
will be used for the coefficients calculation. Double click on any chart where the range 

begins (start  record);  the Records Range window will 
show up. The user can change record number value in 
this window. 
Repeat the procedure where the range ends (end record).

If  any of magnetic  channel  is  missing (not selected),  the record range can not be 
specified.  An error message will appear, for example:

The selected record range is highlighted on the charts.  Start  and end records  are 
indicated:

       © Pico Envirotec Inc.                                                                                         14 / 25 

End recordStart record



PEICompensation February 2009

 The following message appears to confirm the range saving:

If  OK is  clicked  the  user  will  be asked to  select  X coordinate  and Y coordinate 
channels. They are used to calculate heading of the selected range that will be assigned to 
the  set of coefficients.

When X/Ychannels are selected click OK. The range file will be saved:

If 'Yes' is clicked the source file will be closed.  Created range file will be opened for 
coefficients calculating.

Note that Record channel (RECS) is always added to the range file even it was not 
selected by the user. Greated range file is named in the following way:

• Heading is added to the original file name
• Letter 'P' in the file extention is changed to 'H'.
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Range file header is similar to source file header but also contains heading 
information:

2.2.2.1 Change Record Range 
If necessary,  the selected record range can be changed before range file is saved. 

Clear the selected range using ‘Clear Range’ item in the Edit menu:

A new range can be specified.

2.2.2.2 Change Selected Channels
If wrong data channel(s) was (were) included into a range file, a new file has to be 

created.
Use 'Selelect Channel' drop down list to select proper magnetic and altitude channels.
X and Y coordinate channels can be set using 'Set X,Y coordinates' item in the Edit 

menu.
When new selection has been made the range file can be saved using 'Save Range' 

item in the File menu:

       © Pico Envirotec Inc.                                                                                         16 / 25 



PEICompensation February 2009

2.2.3 Calculate Compensation Coefficients
All four headings compensation coefficients have to be saved into one file. Each 

range file has to be opened and coefficients calculated. 
When all available headings are processed, coefficient file has to be saved. 
Do not save coefficient file of each heading separately. 

Open a range  file.  Fluxgate  (X,  Y,  Z)   and  raw magnetometer  data  channels  are 
selected automatically and charts  displayed.  Coefficients  can be calculated using item 
‘Calculate Coefficients’ in the Coefficients menu.

Range file heading is displayed in the bottom section of the window. If coefficients 
are calculated the heading is added to the list of calculated headings: 
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When  all  headings  coefficients  are  calculated  use  ‘Save  calculation’  item in  the 
Coefficients menu to save calculated coefficients into a coefficient file. The file name 
starts  with ‘MGS’;  the  extension  is  '.cor'.  The  message  similar  to  the  following will 
appear:

2.2.3.1 Edit Range File
The data can be edited before coefficients  are calculated.  Click in a chart   where 

correction is needed. Edit screen will appear:

Ten  records  data  is  displayed.  When  mouse  pointer  is  moving  over  a  chart,  the 
corresponding record cell in spreadsheet is activated (record 904 on the picture above).

After editing; if OK is clicked data is saved in a buffer not into a file. This process 
can be repeated for all records that require correction. To save modified data in the range 
file use  item ‘Save’ in the File menu.
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If data was not saved in the range file after editing, the user will be asked to confirm 
changes before coefficients are calculated:

2.2.3.2 Recalculate Coefficients
It is possible to remove coefficients of any calculated heading. Click on item ‘Clear 

Coefficients’ in the Edit menu:

Clear Direction window comes out:

Select required heading (direction) in a drop down window. All headings item can be 
also selected. Coefficients of the selected heading will be cleared:

The user can then make any corrections  to  the data  or selected  record range and 
recalculate the coefficients.
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2.2.4 Test Coefficients
The user can test calculated coefficients. Click on ‘Magnetic Compensation’ item in 

the Coefficients menu. This provision is enabled if a range file is opened in PEIComp.
Raw and Compensated Data Charts will appear:

Raw and compensated magnetic data is displayed in the same chart. The bottom chart 
shows the difference between compensated and raw data. The horizontal axis represents 
record number. The units for the magnetic data is nT.

Data values are updated if mouse pointer is moving over the charts. 
The charts can be zoomed in. Draw selection rectangle with left mouse button in the 

direction from the left  upper corner to the right lower corner.  This procedure can be 
applied several times if needed:
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Draw selection rectangle in the opposite direction to return to the original scale (zoom 
out).

If more than one raw data channel exists in  the file, select the next channel from the 
Raw Mag Data drop down window:

After all data was examined open another range file and repeat the test procedure for 
the rest of the headings.
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2.2.5 ASCII Data Import
An ASCII data file can be imported by the PEICompensation program. PEI binary 

format file will be created. Click on the 'ASCII File Import' item in the File menu and 
select an ASCII file in the Open File window:

The ASCII data has to be organized into colomns with the column headers at the top: 

Important. The Record number column is mandatory. Possible names of the column 
are:  <RECS>,  <FID>  or  <FIDS>.  The  record  column  values  are  consecutive  whole 
numbers.

The following picture  demonstrates  an example  of  a  text  file  to be imported  by 
PEIComp. The data has different sampling rate: 

• Alt – 1sps
• LA – 2 sps
• XCol, Ycol – 5 sps
• RMg – 10 sps

       © Pico Envirotec Inc.                                                                                         22 / 25 



PEICompensation February 2009

Note that the first row of each record has no asterisk:

A new file created in PEI binary data format and contains float type (8 bytes) data. 
This  file  can  be  opened  by  PEIComp  application  and  used  as  source  data  for  the 
calculation  of the coefficients.

2.2.6 Set Level (Offset) Coefficients
When  coefficient  file  is  created  the  level  coefficients  are  set  to  zero.  There  is 

provision  in  the  program  to  assign  level  (offset)  coefficient  of  each  heading  in  the 
coefficient file. 

Click on  ‚Level Coefficients‘ item in the Coefficients menu, the Level Coefficients 
window appears. Select the desired coefficient file using the 'Open File' icon. Only the 
files with extention '.cor' can be selected.

Enter offset values of each heading (angle) in the corresponding edit box and save 
the file: 
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 A new coefficients  file  will  be  created.  The  user  can  test  this  file  by  running 
magnetic compensation and view compensation result. See section 2.2.4 for the details.
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3 APPENDIX A: CONTACTS  

Pico Envirotec Inc.,  
222 Snidercroft Rd.,
Concord, Ontario, 
L4K 2K1 Canada
Tel: +1 905 760 9512
Fax: +1 905 760 9513,
E-mail: pei@picoenvirotec.com
Web: www.picoenvirotec.com

AURA, s.r.o.
Uvoz 56
602 00 Brno
Czech Republic
Tel: +420 5 43 245 111
Fax: +420 5 43 245 111
E-mail: engelsmann@aura.cz 
www.aura.cz

       © Pico Envirotec Inc.                                                                                         25 / 25 

http://www.aura.cz/
http://www.picoenvirotec.com/
mailto:pei@picoenvirotec.com

	1 PEICOMP - general:
	1.1 REQUIREMENT FOR MAGNETIC COMPENSATION
	1.2 SOURCES OF MAGNETIC INTERFERENCE
	1.3 REALITY IN COMPENSATING A REAL AIRCRAFT
	1.4 BASES OF COMPENSATION
	1.5 STAGES OF COMPENSATION
	1.6 ACQUISITION WITH AGIS / IRIS

	2 PEICOMPENSATION - USE
	2.1 Install / Setup the Program
	2.2 WORKING WITH PEICOMP Program
	2.2.1 Introduction
	2.2.2 Create Range File
	2.2.2.1 Change Record Range 
	2.2.2.2 Change Selected Channels

	2.2.3 Calculate Compensation Coefficients
	2.2.3.1 Edit Range File
	2.2.3.2 Recalculate Coefficients

	2.2.4 Test Coefficients
	2.2.5 ASCII Data Import
	2.2.6 Set Level (Offset) Coefficients


	3 Appendix A: Contacts

